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 Quelques rappels sur EndNote 
 

 EDITER SES REFERENCES 

 Utilisation avancée des styles 

de publication 

 Comprendre la configuration et 

la syntaxe d’un style 

 Créer et modifier un style 

 Définir la présentation de sa 

bibliographie 
 

 PARAMETRER SA BIBLIOTHEQUE 

 Modifier les paramètres 

EndNote et personnaliser sa 

base 

 

 

 GERER LES PDF 

 Attachement et recherche de PDF 

 Gestion des PDF et PDF Viewer 

 Notices à partir des PDF 

 Trouver le texte intégral 
 

 RETOUR SUR LES GROUPES 

 Les Smart Groups 
 

 IMPORTER DES REFERENCES 

 Utilisation avancée des filtres 

 Utilisation avancée des fichiers de 

connexion 

 Retour sur l’import de références 

depuis un traitement de texte 
 

 ENDNOTE SUR LE WEB 

URFIST Rennes 

2 

17/04/2015 



URFIST Rennes 3 

EndNote Perfectionnement 

Introduction 

 Rappels sur les fonctions d’EndNote  

(Thomson Reuters, http://www.endnote.com/ )  
 Outil d’assistance et de gestion pour : 

 La recherche documentaire 

 L’organisation et l’exploitation de la documentation 

personnelle (références avec regroupement possible + texte 

intégral + images et fichiers + notes) 

 La rédaction et la publication scientifiques, interfaçage avec 

Word et Open Office / Libre Office 
 

 Actuellement : version X7 + EndNote Online = 

interface Web 
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EndNote perfectionnement 

 ÉDITER SES RÉFÉRENCES 

 

Utilisation avancée des styles de 

publication 
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Utilisation avancée des styles de publication 
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Le gestionnaire de styles 



 

 

EndNote Perfectionnement 

Utilisation avancée des styles de publication 

 

 
 Les citations de références 

+ les notes de bas de page 

 

 

 Les bibliographies 
correspondantes : listes 
bibliographiques, listes de 
figures, de tableaux 

 

 Dans le dossier Styles du 
Répertoire EndNote 

 

 

 Citation Author Date 

 (Henninger, 2005) 

 

 Référence au style Harvard 
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 EndNote propose des styles qui contiennent un ensemble 
d’instructions permettant de formater, pour tous les types de 
références : 



 

 

EndNote Perfectionnement 

Utilisation avancée des styles de publication 
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http://endnote.com/downloads/styles   

http://www.endnote.com/downloads/styles


 

 

EndNote Perfectionnement 

Utilisation avancée des styles de publication 

 

 Styles proposé par EndNote 

 
 Actuellement plus de 6000 styles reprenant notamment 

les normes d’écriture des grandes revues scientifiques 
 

 Ils définissent la forme sous laquelle apparaîtront les 
références avec : 
 Format Bibliography  

 Print  

 Export  

 Copy Formatted  

 = noms des champs, ponctuation/caractères spéciaux et texte 

 

 URFIST Rennes 8 17/04/2015 



URFIST Rennes 9 

 Le principe (rappel) 

On peut modifier un style ou en créer de 
nouveaux. Les fichiers styles sont des fichiers 
.ens 

 

C’est le Style Manager qui permet de gérer les 
styles 

 

 Il est conseillé de partir d’un style existant pour 
en créer un nouveau (à enregistrer sous un 
autre nom, format .ens) 

 

 

EndNote Perfectionnement 

Utilisation avancée des styles de publication 
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EndNote Perfectionnement 

Utilisation avancée des styles de publication 

Distinguer les styles publication des styles 
« d’export » 
Styles d’export 

 BibTeX export 
Export des données depuis EndNote dans un format BibTeX 

 

 RefMan (RIS) export 
Export des données depuis EndNote dans un format standard 

d’outil de gestion de références 

Ex : importer sa bibliothèque EndNote sous Zotero 
 

 Tab Delimited 
Export des données sous un format tabulé, pour importer dans 

des bases de données ou des tableurs 

 
17/04/2015 



URFIST Rennes 11 

 Exemple d’export de références 

d’EndNote vers Zotero, en format / style RIS 

 

 

 

 

 

 

 

 Importer ensuite dans Zotero 
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Utilisation avancée des styles de publication 

Choix du style d’export 

RefMan (RIS) Export 

dans le Style Manager 
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EndNote Perfectionnement 

Utilisation avancée des styles de publication 

 Créer un style pour chaque type 
de référence 
 

 Options : 

 About this style : informations 
sur le style 
 

 Punctuation : anglais / français 
 

 Anonymous Works : 
paramétrage pour les œuvres 
anonymes 
 

 Pages Numbers : choix 
d’écriture de la pagination 
 

 Journal Names : forme 
abrégée ou complète 
 

 Sections : bibliographie par 
sections 

Les styles de publication 
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EndNote Perfectionnement 

Utilisation avancée des styles de publication 

 

 Options : 

 Citations : forme des citations 
dans le texte 

 

 Bibliography : forme de la 
référence bibliographique 

 

 Footnotes : forme des notes de 
bas de page 

 

 Figures & Tables   

Les styles de publication 
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EndNote Perfectionnement 

Utilisation avancée des styles de publication 

 Création / Modication d’un 
style 

 Templates : modalités 
de présentation des 
références 

 Reference Types : si 
besoin de formater un 
nouveau type de 
référence 

 Insert Field : pour 
insérer de nouveaux 
champs dans la 
référence + ponctuation 

 Opérer différents 
paramétrages : nom des 
auteurs, séparateurs 
entre les auteurs, ordre 
des noms, initiale de 
prénom… 
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EndNote Perfectionnement 

Utilisation avancée des styles de publication 

 La catégorie Templates définit pour chaque 

type de document : 

 Les noms des champs affichés dans les références à 

l’édition de la bibliographie 

 

 La ponctuation associée 

 

 Les éléments de syntaxe propres à EndNote et 

servant au formatage 
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EndNote Perfectionnement 

Utilisation avancée des styles de publication 

 Le style « Generic » : rappel 
Permet de formater les types de référence qui n’auraient 

pas été définis dans le style. Chaque style doit 

comporter un style Generic qui pourra être utilisé quand 

un type de référence n’aura pas de style défini 

 
 Pour trouver des styles :  

http://endnote.com/downloads/styles  

 Télécharger un style sous Endnote 
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EndNote Perfectionnement 

Utilisation avancée des styles de publication 

 Les 4 règles fondamentales concernant le 
style 

 

1/ Dépendance élémentaire : 
 N’importe quel texte qui n’est pas séparé d’un nom 

de champ par un espace ordinaire dépend du 
champ adjacent. 
 
Cf. Volume (Issue):Pages 
Les parenthèses apparaissent dans la référence mise en 
forme seulement s’il y a un numéro d’issue : BMJ 326 
(7384):339 (sinon ex : BMJ 316 1643-1646) 
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EndNote Perfectionnement 

Utilisation avancée des styles de publication 

2/ Le champ précédent prend l’ascendance 

sur le champ suivant 

 

 Quand la ponctuation apparaît entre 2 champs sans 

espace, elle dépend du champ précédent. 

 

Ex : (Issue):Pages 

le « deux points » dépend du champ « Issue ». Donc 

s’il n’y a pas de N°, les deux points n’apparaissent 

pas. 
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EndNote Perfectionnement 

Utilisation avancée des styles de publication 

 3/  Le premier espace après le champ est dépendant 
du champ. Les espaces supplémentaires sont 
indépendants. 

 Tous les espaces supplémentaires consécutifs sont 
indépendants et apparaîtront tout le temps dans la mise en 
forme des références. 

 ex : pour le style Author. (2 espaces) (Year), on aura en anonyme 
:  

  _(2002). Personalities in Paleontology… 
(remarque : un espace indépendant peut être forcé à être dépendant sur 
un champ adjacent en utilisant le caractère de mise en forme spéciale) 

 

 4/ Le texte indépendant apparaît toujours dans la 
bibliographie 
ex : le texte ed derrière le champ Edition et séparé par un espace 
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EndNote Perfectionnement 

Utilisation avancée des styles de publication 

 Les caractères spéciaux de formatage 
4 caractères spéciaux de mise en forme permettent de moduler la 
mise en œuvre des styles bibliographiques (disponibles par le bouton 
Insert Field) : 

 
 L’espace de non rupture 

 

 Barre verticale (|) : 

 

 Apostrophe arrière (`) 

 

 Accent circonflexe (^ 
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EndNote Perfectionnement 

Utilisation avancée des styles de publication 

 

 L’espace de non rupture (◊) : lie les textes ou la ponctuation à un 
champ. Pour obtenir ce caractère : CTRL+Alt+Barre d’espace 
(Windows) (Link Adjacent Text) 

 

 Barre verticale (|) : sépare les éléments qui sont normalement 
dépendants entre eux (Forced Separation) 

 

 Apostrophe arrière (`) : identifie les textes qui ne seront pas 
interprétés en tant que champ 

 

 Accent circonflexe (^) : sépare les versions simples et multiples 
de labels qui apparaissent avec les auteurs, les éditeurs ou les 
champs de pages (Singular / Plural) 
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EndNote Perfectionnement 

Utilisation avancée des styles de publication 

 

 Pour insérer les caractères spéciaux de formatage : 
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EndNote Perfectionnement 

Utilisation avancée des styles de publication 

 Paramétrages des styles : 
 Ex : Œuvres anonymes 

 Contrôle l’apparence du n° de 
pages 

 Options : 

 Leave author blank (ne 
rien saisir) 

 Use full title in place of 
author (utiliser le titre 
complet en lieu et place du 
nom d’auteur) 

 Use short title in place of 
author (utiliser le titre 
abrégé en lieu et place du 
nom d’auteur) 

 Use APA specifications 

 Insert text : insérer le texte 
de son choix 
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EndNote Perfectionnement 

Utilisation avancée des styles de publication 

 Paramétrages des styles : 
 Ex : Page Numbers 

 Contrôle l’apparence du n° de 
pages 

 Options : 

 Don’t change pages 
number (ne pas modifier le 
n° de page) 

 Show only first page 
number (afficher 
uniquement la 1ère page) 

 Abbreviate last page 
number (abréger la 
dernière page) 

 Show full  range of pages 
(afficher l’intervalle 
complet) 

 Show only the first page 
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EndNote Perfectionnement 

Utilisation avancée des styles de publication 

 Paramétrages des styles 
 Ex : Apparence du nom de 

revue : Journal Names 

 Options : 

 Full Journal Name 

 Abbreviation 1, 2 or 3 

 Don’t replace 

 Abbreviate Journal Article 
only 

 Remove periods (enlève 
les points des nom de 
revues) 
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EndNote Perfectionnement 

Utilisation avancée des styles de publication 

 Produire plusieurs bibliographies par sections 

URFIST Rennes 26 
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EndNote Perfectionnement 

Utilisation avancée des styles de publication 

Modification des 

Templates de la 

bibliographie : 

chaque champ 

pour chaque 

type de 

référence, en 

suivant les 

règles de style 
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EndNote Perfectionnement 

Utilisation avancée des styles de publication 

 Paramétrages des styles / 

Bibliographie 

 Ex : Liste d’auteurs 

«Author Lists» 

 Définit la manière dont la 

série des noms d’auteur  va 

apparaître 

 

 Options : 

 Ponctuation entre les 

noms 

 Nombre de noms inclus 

dans la liste et texte à 

utiliser si la liste est 

abrégée (« et al ») 17/04/2015 
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EndNote Perfectionnement 

Utilisation avancée des styles de publication 

 Paramétrages des styles / 

Bibliographie 

 Ex : Noms d’auteurs 

«Author Names» 

 Définit la manière dont les 

noms de l’auteur et de 

l’éditeur vont apparaître 

 

 Options : 

 Order Nom / Prénom 

 Capitalisation 

 Initiales 
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EndNote Perfectionnement 

Utilisation avancée des styles de publication 

 Paramétrages des styles 
 Ex : Bibliographie / Layout 

 Le préfixe de la référence 
comprend des champs ou du 
texte qui vont précéder toutes 
les références de la 
bibliographie (cf. N°) 

 

 Ex : « Start Each reference 
with » / Insert Field : 
Bibliography Number + 
ponctuation additionnelle 

 

 Le Menu Reference Suffix  
contient des champs ou du 
texte qui suivent les références 
(End Each Reference with) 
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EndNote Perfectionnement 

Utilisation avancée des styles de publication 

 Paramétrages des styles 

 

 Ex : Ordre de la 

bibliographie Bibliography 

> Sort Order pour modifier le 

classement des références 

de la bibliographie 

 

 Title Capitalization : 

utilisation des majuscules 

dans le titre 
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EndNote Perfectionnement 

Utilisation avancée des styles de publication 

 Paramétrages des styles 

 Citations = ce qui va 
apparaître comme 
citation dans le texte : 
 Apparence des noms 

d’auteur pour la première 
citation et pour les 
occurrences suivantes 

 Ponctuation utilisée pour 
séparer des citations 
multiples  

 Numérotation et 
classement (Numbering / 
Sort Order) 
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EndNote Perfectionnement 

Utilisation avancée des styles de publication 

 Paramétrage des styles 

 Notes de bas de page = 

formatage des éléments 

d’information apparaissant 

en note de bas de page 

 Templates 

 Comme la 

bibliographie… 

 Formatage propre 

17/04/2015 
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EndNote Perfectionnement 

Utilisation avancée des styles de publication 

 Notes de bas de page : 
Author /Editor Lists et 
Names 
 Mêmes choix que pour 

Bibliography 

  Notes de bas de page : 
Repeated Citation 
 = manière d’écrire des 

citations répétées en note de 
bas de page 

 Notes de bas de page : Title 
capitalization 
 Utilisation des majuscules 

dans le titre 
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EndNote Perfectionnement 

Utilisation avancée des styles de publication 

 Figures & Tables 
 Figures 

 Positionnement des 
illustrations 

 Dans le cours du 
document, en 
regard de la 
référence 

 Liste à la fin du 
document 

 

 Légende des 
illustrations 
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EndNote Perfectionnement 

Utilisation avancée des styles de publication 

 Figures & Tables 

 Tables 

 Positionnement des 

tableaux 

 Dans le cours du 

document, en 

regard de la 

référence 

 Liste à la fin du 

document 

 

 Légende des tableaux 
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EndNote Perfectionnement 

Utilisation avancée des styles de publication 

 Figures & Tables 

 Separation & 

Punctuation 

 

 Détermine le type de 

séparation  entre les 

illustrations ou 

tableaux selon leur 

positionnement, ainsi 

que la ponctuation 

choisie dans le texte 

les accompagnant 
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EndNote Perfectionnement 

Utilisation avancée des styles de publication 

 Bibliographie thématique 
 Tools > Subject bibliography 

 Par exemple : sélectionner les 

Keywords (tous les mots clés) 

 Bibliographie ordonnée par mots 

clés 

 Bibliographie thématique 

paramétrable par le bouton « 

Layout » 

17/04/2015 
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EndNote Perfectionnement 

Utilisation avancée des styles de publication 

 Les Templates de 

Word 
 Les « Manuscript 

Templates », accessibles 

par le Menu Tools 

d’EndNote sont des 

modèles Word conçus 

pour aider à rédiger un 

article scientifique selon les 

normes des revues. 
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EndNote perfectionnement 

 PARAMÉTRER SA BIBLIOTHÈQUE 

 

Modifier les préférences EndNote et 

personnaliser sa base 
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EndNote Perfectionnement  

Modifier les préférences et personnaliser la bibliothèque 

 Paramétrage des préférences et 

configuration de la bibliothèque 
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EndNote Perfectionnement  

Modifier les préférences et personnaliser la bibliothèque 

 Préférences 
 Libraries  

 choix d’une bibliothèque au 
lancement d’EndNote 

 Display Fonts  

 police et taille des caractères  

 Reference Types  

 choix d’un type par défaut 

 modification : 

 ajouter un type de 
référence 

 compléter un type de 
référence 
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EndNote Perfectionnement  

Modifier les préférences et personnaliser la bibliothèque 

 Préférences 

 Temporary Citations  
 format des citations temporaires 

 Sorting  
 classement des références 

 Change Case 
 options relatives à la casse 

 Formatting  
 Options de formatage  

 Display Fields  
 champs affichés 
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EndNote Perfectionnement  

Modifier les préférences et personnaliser la bibliothèque 

 Préférences 
 Duplicates  

 critères de reconnaissance des doublons 

 Online 
 sélection du navigateur et des logs de connexion 

 Folder Locations  
 répertoires par défaut 

 Term Lists  
 préférences pour les listes de termes 

 Spell & Check 
 options de contrôle d’orthographe et dictionnaires 

 URLs & Links 
 activation du retour à la référence dans la base de données 

extérieure (URL) ou au texte intégral (URL > OpenURL Link) 

 Find Full Text : PDF disponibles, etc. + Handling PDF 
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EndNote Perfectionnement    

Configurer des Groupes par requête 

 Groupes créés à partir d’une requête 

 > Create Smart Groupe 

 Convertir une requête en Smart Group 

 

 Alimenté automatiquement à chaque qu’un 

document entré dans la base correspond à la 

requête 

URFIST Rennes 45 
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EndNote Perfectionnement 

 GERER LES PDF 

 

Attachement et recherche de PDF 

Gestion des PDF et PDF Viewer 

Notices à partir des PDF 

Trouver le texte intégral 
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EndNote Perfectionnement 

Attacher un document à une références 

 Rappels : Liens vers une page web, un 

fichier sur le disque dur (texte intégral, pdf, 

doc, image) 

 
 Utiliser les champ URL, File Attachments et Figure 

 Saisir l’URL de la page web 

 Lien vers un fichier  

 References > File Attachments > Attach File 

 Lien vers une illustration :  

 References > Figure > Attach Figure 
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EndNote Perfectionnement 

Attacher un document à une références 

 Ouvrir L’ URL 

 References> URL > Open URL 

 Ouvrir le fichier 

 References> File Attachments > Open File 

 Ouvir le fichier image 

 References> Figure > Open Figure 

 

 Find Full Text :  localiser le texte intégral 
(paramétrage dans Edit > Preferences > Finding 
Full Text 
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EndNote Perfectionnement 

Attacher un document à une références 

 Attachement de PDF et recherche des 

PDF associés aux références 
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EndNote Perfectionnement 

Le PDF Viewer 

 PDF Viewer : 

 

 affichage des 

documents en texte 

intégral dans une 

interface spécifique 
 

 Possibilité d’annoter, 

de surligner le PDF 
 

 Possibilité de 

rechercher dans le 

contenu des PDF 
 

 Zoom, rotation… 
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EndNote Perfectionnement 

Gestion des PDF 
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Préférences : 

PDF Handling 

 
Renommage 

des PDF 

 
Import 

automatique de 

PDF dans 

EndNote depuis 

un dossier de 

PDF 



EndNote Perfectionnement 

Créer des notices par import de PDF 

 

 Import de fichiers PDF ou de dossiers de 

PDF 

 cela ne fonctionne qu’avec les pdf des 

éditeurs (qui contiennent les métadonnées 

nécessaires via CrossRef et le DOI de 

l’article) 
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EndNote Perfectionnement Trouver le texte 

intégral 

 Find Full Text 

 Selon abonnements 

 À configurer dans les Préférences 
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EndNote Perfectionnement 

 IMPORTER DES RÉFÉRENCES 

 

Utilisation avancée des filtres 

Utilisation avancée des fichiers de 

connexion 

Retour sur l’import de références depuis 

un traitement de texte 
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EndNote Perfectionnement 

Utilisation avancée des filtres 

 Rappel sur l’import de références.  
 
Possibilité d’importer automatiquement des 
références : 
 
 Depuis les interfaces de bases de données et 

bouquets / sites de revues électroniques  

 

 Depuis des fichiers de références sauvegardés 
issus de recherches documentaires et importés grâce 
à des filtres d’import  
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EndNote Perfectionnement 

Utilisation avancée des filtres 

 

Sous EndNote même, par une connexion 

directe à des bases de données distantes 

(grâce à des fichiers de connexion) 

 

Depuis des bases créées sous d’autres 

logiciels de gestion bibliographiques  

 

Depuis d’autres bases EndNote 
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EndNote Perfectionnement 

Utilisation avancée des filtres 

 Que faire s’il n’existe pas de possibilité 
d’import pour la source consultée : 

 
 Vérifier sur le site endnote.com, que le filtre ou le fichier de 

connexion n’ont pas été développés depuis 

 

 Rechercher sur le web si le filtre ou le fichier de connexion n’ont 
pas été élaborés par un organisme 

 

 Créer soi-même son propre filtre ou fichier de connexion 

 Comprendre la structure d’un filtre 

 Adapter un filtre existant à ses besoins 

 Créer un filtre complètement nouveau 
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EndNote Perfectionnement 

Utilisation avancée des filtres 

 

 

 

Accès aux filtres par 

le Gestionnaire de 

filtres 

1ère catégorie : About 

This Filter : 

- Caractéristiques 

générales du filtre 

- Instructions de 

transfert des 

références 
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EndNote Perfectionnement 

Utilisation avancée des filtres 

 La ligne « About This Filter »  

 
 Name = nom du fichier, il peut 

être modifié (par File > Save as) 

 Based on = informations 
utilisées pour créer le filtre (lien 
vers le site web où se trouvent 
les instructions 

 Category = pour créer des 
filtres par catégorie ou 
fournisseur. 

 Created / Last modified = 
mentions de date 

 Comments and Limitations = 
peut contenir des informations 
facilitant l’import (par ex. 
manière de récupérer les 
données)  
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EndNote Perfectionnement 

Utilisation avancée des filtres  

 La ligne « Templates »  

 Son usage : 
 Créer des correspondances 

entre les étiquettes du 
fichier texte à importer et 
les champs EndNote 

 

 Pour chaque type de 
référence 

 

 Demander que le contenu 
de certaines étiquettes ne 
soit pas récupéré en 
utilisant l’option {IGNORE} 

 

 Insérer des étiquettes / 
Champs : Insert Fields 

17/04/2015 



URFIST Rennes 61 

EndNote Perfectionnement 

Utilisation avancée des filtres 

 La ligne « Author Parsing »  

 ( champ Author) 

 

 Name Order = ordre dans lequel 
doivent être repris le nom et le 
prénom de l’auteur 

 

 Interpreting First Name As = 3 
valeurs possibles : 
 Smart : EndNote applique son 

algorithme, s’il y a 3 lettres 
majuscules contigües ou moins, 
ces lettres sont importées en 
tant qu’initiales, sinon elles le 
sont en tant que nom complet 

 Whole Names 

 Initials Only 

 

 
17/04/2015 



URFIST Rennes 62 

EndNote Perfectionnement 

Utilisation avancée des filtres 

 Author Name Separators 

 

 Between Authors : Défini 

par défaut à Smart 

 

 Reconnaît comme 

séparateurs « ; » « ^ » 

« | » pour déterminer la fin 

d’un nom d’auteur 

 

 Si cela ne convient pas, 

définir le séparateur qui 

convient 

 

 Last & First Names 

 L’option Smart reconnaît 

comme séparateurs 

l’espace, la virgule et le 

point. 

 

 Définir éventuellement 

d’autres séparateurs 

 

 Parenthetical Data in Author 

Field 

 Pour importer ou non des 

données mentionnées entre 

parenthèses au niveau du nom 

d’auteur (dates par ex.) 
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EndNote Perfectionnement 

Utilisation avancée des filtres 

 La ligne « Continuation 
Lines » 
 EndNote ignore les lignes 

non précédées d’une 
étiquette, sauf si la ligne est 
la ligne suivante du texte de 
départ. 

 

 Exemple : 
AB- A single-subject 
research design that used  
multiple baselines across 
behaviors compared  
traditional adaptations to 
computers. 
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EndNote Perfectionnement 

Utilisation avancée des filtres 

 Options 
 « Ignore Indents : Untagged lines are always a continuation 

of the preceding line » = toutes les lignes du texte seront 
importées selon les étiquettes, les lignes qui n’ont pas 
d’étiquette se suivent, appartiennent à la même étiquette. 

 

 « Continuation lines must be indented » = pour définir le 
nombre d’espaces dans la marge gauche pour la ligne continue. 

 
 En choisissant l’option « Smart Indent Identification », 

l’importation sera correcte. 

 Possibilité de définir l’indentation au niveau des lignes suivantes 
pour un champ donné (à gauche du champ).  
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EndNote Perfectionnement 

Utilisation avancée des filtres 

 La ligne « Reference 
Type » 
 Default Reference Type = 

définit quel type de référence 
adopter s’il n’est pas possible 
d’identifier le type de 
référence d’une notice   

 

 Identifier = 
Pour importer un fichier de 
résultats issus de plusieurs 
bases de données = 
l’étiquette fournisseur + nom 
du fournisseur et l’étiquette 
base de données et le nom de 
la base. 
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EndNote Perfectionnement 

Utilisation avancée des filtres 

 La ligne Editor Parsing 

 Option analogue à l’option 
« Author Parsing » 

 

 s’applique aux champs : 
 « Editors’ » 

  Translators’ »  

 « Other Authors » 

 

 qui correspondent aux 
noms de champs 
génériques : 
  « Secondary Author’ » 

  « Tertiary Author’ »  

 « Subsidiary Author’ » 17/04/2015 
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EndNote Perfectionnement 

Utilisation avancée des filtres 

 La ligne « Field Editing » 
 Permet de définir comment 

convertir, pour un champ donné, 
un texte qui est en lettres 
majuscules 

 Options : 
 Sentence : le 1er mot en 

majuscule 

 Headline : chaque mot a une 
majuscule à l’initiale 

 Lowercase format : tout en 
minuscules 

 Do NOT Lowercase : laisser en 
majuscules 

 Permet de définir les caractères 
à ôter lors de l’import. 
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EndNote Perfectionnement 

Utilisation avancée des filtres 

 « MARC Records » 
 Pour définir les règles d’import 

concernant les notices en 
format MARC. 

 « Record Layout » 
 Pour définir la manière dont 

EndNote délimite les 
enregistrements. 
 Smart record identification 

(étiquette précédée d’un blanc 
ou d’une ligne indépendante) 

 Blank line separates 
records 

 First Tag 

 Last Tag 

 Each Record ends with 

 Each Record starts with 
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EndNote Perfectionnement 

Utilisation avancée des filtres 

 La Ligne «Source Parsing» 

 
 Champ Source = champ complexe 

et hétérogène 

 

 Permet d’identifier l’étiquette du 
champ Source 

 

 Permet d’avoir plusieurs options de 
traitement du champ Source dans 
les Templates de Journal Article 

 

 Toutes les informations qui ne sont 
pas importées correctement, sont 
importées dans le champ Note, 
avec la mention « Using Smart 
Source Parsing ». 
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EndNote Perfectionnement 

Utilisation avancée des fichiers de connexion 

 Interrogation de bases de données distantes 
directement depuis EndNote par les fichiers de 
connexion 

 Rapatriement des références dans la bibliothèque 
EndNote 

 EndNote utilise pour cela un protocole de recherche 
d’information appelé Z39.50 (cf. accès à des 
catalogues de bibliothèques + bases de données) 

 Intègre le protocole TCP/IP ainsi qu’une surcouche 
autorisant l’interrogation et le rapatriement des 
données 

 Utilisation du Menu Tools > Online Search 
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EndNote Perfectionnement 

Utilisation avancée des fichiers de connexion 

 Le « Connection Manager» (Menu Edit) 

 

Voir les 

propriétés 

du fichier de 

connexion 

Permet de 

gérer les 

fichiers de 

connexion 
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EndNote Perfectionnement 

Utilisation avancée des fichiers de connexion 

Il est 

nécessaire 

qu’un 

ensemble de 

paramètres 

soient définis 

pour les 

fichiers de 

connexion 
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EndNote Perfectionnement 

Utilisation avancée des fichiers de connexion 

 Paramètres de 
connexion 
 Server 

 Nom du site serveur 

 Server Address  
 Adresse internet qui 

permet de réaliser la 
connexion 

 Database 
 Nom de la base de 

données qui apparaîtra 
lors de la connexion 

 Database Name 
 Nom de la base de 

données localement (pour 
sélectionner la base sur le 
serveur distant) 
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EndNote Perfectionnement 

Utilisation avancée des fichiers de connexion 

 Paramètres de connexion 

(suite) 

 Element Set  

 Normalement F pour Full ou B 

pour Brief 

 Port ID  

 Port de sortie au niveau 

internet 

 Record Syntax 

 = manière dont sont stockées 

les informations, format 

standard d’échange en 

bibliographie (USMARC, 

UNIMARC…) 

 Text 

 ANSEL, c’est le format 
classique utilisé avec le 
format USMARC 

 UNICODE : spécifie un 
n° unique pour chaque 
caractère, quelle que 
soit la plate-forme, le 
logiciel et la langue. 

 User ID  

 Nom d’utilisateur si le 
site demande une 
authentification 

 Password 
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EndNote Perfectionnement 

Utilisation avancée des fichiers de connexion 

 Search Attributes 
= manière d’interroger la base 

distante 

 
 Search Field Name : nom 

du champ qui apparaît dans 
la fenêtre de recherche 
 

 Use :  
 n° d’identifiant pour l’index 

sur lequel doit être réalisé la 
recherche (obligatoire alors 
que les autres attributs sont 
souvent vides dans les 
options par défaut du 
serveur) 
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EndNote Perfectionnement 

Utilisation avancée des fichiers de connexion 

 Relation :  

 relation entre les termes 
recherchés dans l’index 
 

 Position :  

 position du terme recherché 
dans le champ de 
l’enregistrement de type MARC 

 

 Structure :  

 structure des termes tels que 
mots ou phrases 

 

 Truncation :  

 options de troncature 

 Completeness :  

 indique si le terme 
recherché doit être le sous 
champ complet dans 
l’enregistrement de type 
MARC correspondant au 
champ recherché 

 

 Les connexions peuvent poser 
problème sur les sites équipés 
de Firewall. S’adresser dans 
ce cas à l’administrateur 
internet. 
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EndNote Perfectionnement 

Retour sur l’import de références depuis un 

fichier de traitement de texte 

 Données qui ne sont pas dans un 
format propre à l’import : 

 

 4 possibilités : 
 Remettre en forme les données avec le traitement de 

texte (pour bibliographie importante) 

 Refaire la recherche documentaire 

 Copier coller chaque ensemble de données dans les 
champs EndNote 

 Saisir manuellement les données dans EndNote 
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EndNote Perfectionnement 

Retour sur l’import de références depuis un 

fichier de traitement de texte 

 Remise en forme du texte 
 Création d’un fichier délimité par 

des tabulations 

 

 Fichier dont chaque 
référence est délimitée par 
un retour chariot et les 
champs de la référence 
sont séparés par des 
tabulations 

 

 Option d’Import = « Tab 
Delimited »  
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EndNote Perfectionnement 

Retour sur l’import de références depuis un 

fichier de traitement de texte 

 Préparation des données 
 Séparer les noms d’auteur par un point-virgule ou par 2 slash « 

// » 

 Vérifier la présence d’un champ indiquant le type de référence 
(si différents types) = indiquer des types de référence EndNote 

 Transformer le fichier en fichier délimité par des tabulations (.txt) 

 Dans le traitement de texte, rajouter 2 lignes au fichier 

 

 Import 
 Dans EndNote : File > Import avec option Tab Delimited 
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EndNote Perfectionnement 

Retour sur l’import de références depuis un 

fichier de traitement de texte 

 1ère ligne = 

 * nom de référence EndNote et retour chariot 

 Exemple :  
 *Journal Article <Retour chariot> 

 Dans le cas où il n’y a pas de fichier séparé par type 
de référence, définir chaque type de référence 
individuellement; la 1ère ligne doit être dans ce cas : 

    *Generic <Retour chariot> 

 2ème ligne = noms de champ EndNote : 

    *Generic 

Reference Type  Author  Year Title Secondary Title 
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EndNote Perfectionnement 

EndNote Web / « EndNote Online » 

17/04/2015 

Une version de base gratuite 



EndNote Perfectionnement 

EndNote Web / « EndNote Online » 

 Créer son compte sur EndNote Online : 

http://www.myendnoteweb.com/  

 Se connecter` 

 Utiliser le bouton de synchronisation d’EndNote 

local pour mettre sa bibliothèque de références 

en ligne 

 Travailler en ligne sur sa bibliothèque  

 Synchroniser en ligne sa bibliothèque locale  
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EndNote Perfectionnement 

EndNote Web / « EndNote Online » 

 

 Accès à un espace 

personnel de gestion 

de ses références 
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EndNote Perfectionnement 

EndNote Web / « EndNote Online » 
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Recherche en ligne et ajout de références à la bibliothèque 

Sous l’onglet Collect : 

 

Saisie manuelle – import par filtre  



EndNote Perfectionnement 

EndNote Web / « EndNote Online » 

 Installer le bouton ou la barre de capture EndNote, 

consulter une ressource documentaire et capturer 

les références 
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EndNote Perfectionnement 

EndNote Web / « EndNote Online » 

 Autres possibilités : 

 Gestion des références 
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EndNote Perfectionnement 

EndNote Web / « EndNote Online » 

 Citer 
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EndNote Perfectionnement 

EndNote Web / « EndNote Online » 

 Fonctions collaborative avec l’onglet 

« Connect » 
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